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Author Questionnaire
1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  Enter Yes or No.  
If Yes, can you record movies/images using your own microscope camera?
Enter Yes or No.  
If your protocol involves microscopy but you are not able to record movies/images with your microscope camera, JoVE will need to use our scope kit. 
If your microscope does not have a camera port, the scope kit will be attached to one of the eyepieces and you will have to perform the procedure using one eye.
Enter make and model of microscope.
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
Click here to list microscope shots, using the shot numbers from the protocol section of the video script.

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Enter Yes or No.
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
As these files are necessary for finalizing your script, please upload all screen-captured video files to your project page as soon as possible.

3. Filming location: Will the filming need to take place in multiple locations?   Enter Yes or No.
If Yes, how far apart are the locations? Click to enter distance between locations.

To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)

Current Protocol Length
Number of Steps:  24
Number of Shots:  46

Introduction
Videographer: Obtain headshots for all authors available at the filming location. 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer the 1st REQUIRED question and at least 2 other questions (1.2 – 1.10) below. Up to 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· If possible, each author should deliver no more than two statements.
· Answer in full sentences, in a style suitable for being spoken aloud. 
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Enter author name.: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What are the current experimental challenges?
1.4. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What significant findings have you established in your field?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What research gap are you addressing with your protocol?
1.6. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What advantage does your protocol offer compared to other techniques?
1.7. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
How will your findings advance research in your field?
1.8. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What new scientific questions have your results paved the way for?
1.9. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What research questions will your laboratory focus on in the future?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.


Videographer: Obtain headshots for all authors available at the filming location.

Testimonial Questions (OPTIONAL): 

Videographer: 

· Please ensure that all testimonial shots are captured in a wide-angle format, while also maintaining sufficient headspace, given that the final videos will be rendered in a 1:1 aspect ratio.
· Also, kindly note that testimonial statements will be presented live by the authors, offering their spontaneous perspectives.

· Note: Testimonial statements will not appear in the video but may be featured in our promotional materials.
· Provide the full name and position (e.g., Director of [Institute Name], Senior Researcher [University Name], etc.) of the author delivering the testimonial. This will appear in our journal’s promotional materials.
· During the shoot, the author should speak naturally in their own words, using complete sentences and a conversational tone—no script will be provided.

How do you think publishing with JoVE will enhance the visibility and impact of your research?
1.11. Enter author name, Enter author title: (authors will present their testimonial statements live)
Can you share a specific success story or benefit you’ve experienced—or expect to experience—after using or publishing with JoVE? (This could include increased collaborations, citations, funding opportunities, streamlined lab procedures, reduced training time, cost savings in the lab, or improved lab productivity.)
1.12. Enter author name, Enter author title: (authors will present their testimonial statements live)


Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) with purple font are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that the videographer will capture. 

2. Quantitative Analysis of Nuclear Dynamics via FIJI and TrackMate Using mCherry and SiR-DNA Channels
Demonstrator: Click here to enter name of demonstrator(s) 

If the same person is the demonstrator throughout, mention them once here and remove the "Demonstrator" field from the other sections; if the demonstrator changes, retain the field in the respective sections.

2.1. To begin, launch the FIJI software on the computer system [1]. 
2.1.1. WIDE: Talent launching the FIJI software. 
2.2. Select the stable phase as Image1, the illumination phase as Image2, and the recovery phase as Image3 [1]. Merge the mCherry (M-Cherry) channel as channel 1 and the SiR-DNA (Sir-D-N-A) channel as channel 2 to produce a single image representing all three phases [2].
Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible: https://review.jove.com/account/file-uploader?src=20918473
2.2.1. WIDE: Talent selecting each phase and assigning Image1, Image2, and Image3. 
2.2.2. SCREEN: Show software merging the two channels into a single composite image.
2.3. Save the obtained merged image for segmentation by navigating to File and selecting Save As Tiff... (Save-As-Tiff)  [1].
2.3.1. SCREEN: Navigate to File, click Save As, and choose Tiff... to save the image.
2.4. Next, split the mCherry channel by selecting Image, Color and Split Channels [1]. Then, save the split image by going to File, Save As and Tiff... [2].
2.4.1. SCREEN: Image> color> Split channels is being selected.  
2.4.2. SCREEN: File > Save As> Tiff… is being clicked. 

2.5. To check for eventual bleaching during acquisition, run the Plot Z-axis Profile on the mCherry channel by sequentially selecting Image, Stacks and Plot Z-axis Profile [1]. The click on Data followed by Copy 1st Data Set and paste it into the provided spreadsheet under the Z-axis profile cell [2].
2.5.1. SCREEN: Click on Image> Stacks> Plot Z-axis profile to run the Plot Z-axis Profile command.
2.5.2. SCREEN: Data | Copy 1st Data Set is being clicked and pasted into the ready to use spreadsheet.
2.6. Now, draw a circular region of interest approximating the average size of a nucleus by clicking on Analyze followed by Tools and click on ROI (R-O-I) Manager [1]. Add the ROI and save it by navigating to More and clicking on Save... [2].
2.6.1. SCREEN: ROI Manager is being opened from  Analyse > Tools. 
2.6.2. SCREEN: ROI is being added. Then More> Save As… is being clicked. 

2.7. Place the saved ROI in a cell-free region during the time-lapse [1]. Ensure Mean grey value is selected under Analyze and Set Measurements [2]. Click on More Multi Measure, check Measure all 50 slices and one row per slice, and click OK to record the intensity [3].
2.7.1. SCREEN:  The ROI is being placed in a background area. 
2.7.2. SCREEN: Analyze> Set Measurements is being selected then Mean Grey value is being checked.  
2.7.3. SCREEN: More> Multi Measure is being clicked. Measure all 50 slices and one raw per is being ticked then OK is being pressed. 
2.8. Copy and paste all measured intensity values into the provided spreadsheet under the ROI Background cell [1]. Then close the image with only the mCherry channel [2] and select the saved image with merged channels [3].
2.8.1. SCREEN: Copying values from ROI measurements and pasting into spreadsheet.
2.8.2. SCREEN: The split mCherry image is being closed. 
2.8.3. SCREEN: The previously saved merged image is being opened.
2.9. Now open the TrackMate plugin by sequentially clicking on Plugins, Tracking and TrackMate [1]. Confirm that time points range from 0 to 49 and click Next [2].
2.9.1. SCREEN: Plugin menu navigation to TrackMate.
2.9.2. SCREEN: Verifying time point settings in TrackMate.
2.10. Select the StarDist (Star-disst) detector and click Next [1]. Choose channel 2 (SiR-DNA) (channel-two-Sir-D-N-A) for nuclei segmentation and wait for the process to complete [2]. Leave default parameters in the thresholding window and click Next [3].
2.10.1. SCREEN: Selecting StarDist and proceeding. 
2.10.2. SCREEN: Channel 2 selected for segmentation and progress bar shown.
2.10.3. SCREEN: Thresholding window with default settings confirmed.
2.11. Create filters using Mean intensity ch1 (Mean-Intensity-Channel-One)  to exclude nuclei with extreme signal values. Create one filter to select values above the defined threshold and the other to select the values below the threshold [1-TXT]. Similarly, add two Area filters to remove debris or dying cells and click Next [2].
2.11.1. SCREEN: Two filters with Mean intensity Ch1 are being created.  TXT: Define the value to only remove the very low or saturated signal
2.11.2. SCREEN: Setting up area-based filters and proceeding.
2.12. Choose the Simple LAP tracker and click Next [1].
2.12.1. SCREEN: Tracker selection window showing Simple LAP option.
2.13. Next, adjust tracking parameters. Set the Linking max distance to 30 micrometers, the Gap-closing (gap-closing) max distance to 15 micrometers, and Gap-closing max frame gap to 3, then click Next [1].
2.13.1. SCREEN: The tracking parameters are being set. 
2.14. After calculations, click on Next to set filters on tracks [1]. To only select nuclei that have been tracked during the entire time course, choose the highest number of spots in the track and click Next [1].
2.14.1. SCREEN: Next is being clicked after calculations are done. 
2.14.2. SCREEN: The highest number of spots in the track are being selected and Next is pressed. 
2.15. Then tick Display spot names to be able to retrace each nucleus in further analyses and customize other display features as preferred [1]. At the page bottom, click on Tracks and choose Export to CSV to save the measurement table [2]. Close the table and proceed by clicking Next [3].
2.15.1. SCREEN: Display options with spot names is being enabled.
2.15.2. SCREEN: Exporting table as CSV file. 
2.15.3. SCREEN: Closing the table and navigating to next step.
2.16. Now, click on Capture overlay as action and then press on Execute followed by OK to generate an image with tracked nuclei [1]. Save the image by sequentially clicking on  File, Save As and choosing Tiff... [2].
2.16.1. SCREEN: Capturing overlay is being clicked then Execute > OK is pressed and image with tracked nuclei is seen.  
2.16.2. SCREEN: File> save As> Tiff is being clicked. 
2.17. To import the TrackMate CSV file into a spreadsheet, click on the Data tab. Under the Get & Transform Data group, click on From Text/CSV (From-text-or-C-S-V) and click Import [1].
2.17.1. SCREEN: Data tab is being pressed. Under Get and Transform, From Text/CSV is pressed and import is being clicked. 
2.18. Copy columns Spot ID (B) (Spot-I-D-B) , Track ID (C) (Track-I-D-C), Frame (I) (Frame-I), and Mean intensity ch1 (M) (Mean-intensity-channel-1-M), and paste into columns A to D of the provided spreadsheet [1].
2.18.1. SCREEN: Selecting and copying specified columns and pasting them into the spreadsheet.
2.19. Sort the results alphabetically first by Track ID (individual nucleus) (Track-I-D-Individual-Nucleus)  from cell B5 and then by Frame (Time Point) (Frame-Time-Point) from cell C5 [1].
2.19.1. SCREEN: Sorting Track ID and Frame columns in spreadsheet.
2.20. Now, create a new sheet and copy-paste the 'time' column from the spreadsheet [1].
2.20.1. SCREEN: Creating a new worksheet and transferring the time data.
2.21. To generate the relative nuclear intensity graph, navigate to the Graphs section and select XY as the graph family  then choose Points & connecting line with error bars as the graph type [1]. In the Plot settings, choose Mean, Error, and SEM, and click OK [2].
2.21.1. SCREEN: Graph  section is being navigated to, then XY is being set as the graph family and Points & connecting line with error bars is being set as the graph type.  
2.21.2. SCREEN: Mean, Error and SEM is being selected in the Plot settings and OK is being pressed. 
2.22. Next, click on New Data Table and enter the times in decimals only for stable and illumination phases [1]. Paste the values obtained as relative nuclear intensity for these phases into the table [2].
2.22.1. SCREEN: New table showing input for stable and illumination phase times.
2.22.2. SCREEN: Nuclear intensity values entered.
2.23. In the Results section, click on XY analyses followed by Exponential then choose Nonlinear Regression (Curve Fit) (Curve-fit) and click OK [1]. Select Plateau followed by one phase decay as Model under the parameters. Then choose a constant equal to 2.25 as X0, a constant equal to 1 as Y0 and , a constant equal to 0 for the plateau [2]. Indicate that K  should be greater than 0 and press OK [3]. 
2.23.1. SCREEN: Nonlinear Regression Curve Fit is being selected from the Results section. 
2.23.2. SCREEN: Plateau followed by one phase decay as Model is being selected under parameters then constant X0, Y0 and plateau are being set. 
2.23.3. SCREEN: K is being set to greater than 0 and OK is pressed. 
2.24. Create a new table and paste-transpose the K values obtained [1]. In the Graphs section, select Column as graph family. Then in the Box and violin section, choose the Violin plot as the graph type [2]. Select Show all points as the plot and click OK [3].
2.24.1. SCREEN: New table is being created and K values are being pasted and transposed. 
2.24.2. SCREEN: Column is being selected as graph family, Violin plot is being set as graph type. 
2.24.3. SCREEN: Show all points is being selected as the plot and OK is being pressed. 

2.24.4. 

Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 125
· Please note that the video cannot include voiceover without an accompanying visual.

3. Results 
AUTHORS: Please confirm that the results have been accurately summarized. 
3.1. Nuclear export with LEXY was visualized [1].  In methanol-treated cells, nuclear mCherry intensity sharply decreased after blue light illumination [2], followed by a gradual recovery during the post-illumination phase [3].
3.1.1. LAB MEDIA: Figure 4.
3.1.2. LAB MEDIA: Figure 4. Video editor: Highlight the stable and illumination images in the Methanol row
3.1.3. LAB MEDIA: Figure 4. Video editor: Highlight the recovery image In the Methanol row 
3.2. Leptomycin B caused a change in nuclear export, as the probe signal remained consistently nuclear throughout all timepoints [1].
3.2.1. LAB MEDIA: Figure 4. Video editor: Highlight the Leptomycin B 1 nM  and 0.5 nm rows
3.3. Quantitative analysis of relative nuclear intensity showed over time a slow decrease until reaching a plateau at the end of the illumination phase [1]. Intermediate Leptomycin B concentrations should display a mild nuclear export [2]. 
3.3.1. LAB MEDIA: Figure 5A. Video editor: Highlight the Leptomycin B 1 nM curve
3.3.2. LAB MEDIA: Figure 5A. Video editor: Highlight the Leptomycin B 0.5 nM curve
3.4. Export rates calculated from the intensity data confirmed a significantly higher export rate in methanol-treated cells [1], a much lower rate with 0.5 nanomolar Leptomycin B [2], and almost no export at 1 nanomolar Leptomycin B [3].
3.4.1. LAB MEDIA: Figure 5B. Video editor: Highlight the violin plot for methanol
3.4.2. LAB MEDIA: Figure 5B. Video editor: Highlight the violin plot for Leptomycin B 0.5 nM
3.4.3. LAB MEDIA: Figure 5B. Video editor: Highlight the violin plot for Leptomycin B 1 nM, 
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